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The PlaceLab: Testing High 
Tech in a Home Environment
• Lee Ridgway

ew full-serv condo, betw MIT/
Harv. 1000 sq ft, furn. Liv rm, 

din rm, bdrm, offc, 1-½ bths, kitch, 
W/D. Avail shrt-trm. FREE!

Now that’s a real-estate ad to grab your 
attention! So what’s the catch? Well, you 
need to be a participant in a PlaceLab 
research project. And what is the Place- 
Lab? An innovative concept for study- 
ing technologies for everyday living in 
a true home environment. The PlaceLab 
is a real condo, in a real condo building, 
which has been turned into a live-in 
laboratory, equipped with all the com- 
forts of home, and then some.

A Sensory Environment
The PlaceLab, begun in 2003, is a 

collaboration between the MIT House_n 
consortium and TIAX, an independent 
research company based in Cambridge. 
House_n is a multidisciplinary project  
in the Department of Architecture, led 
by Kent Larson, with Stephen Intille  
as technology director. In an interview, 
Intille filled out the details of the Place- 
Lab and the kinds of research it is in- 
tended to support.

From outward appearances, the 
PlaceLab looks like a typical contem- 
porary apartment. Not so apparent are 
the sensors, cameras, and microphones 
that can record just about every aspect 
of the research participants’ activities 

as they go about their daily living. 
Behind the walls is a complex infra-
structure of cabling, connectors, com- 
puters, and controllers within closed 
cabinets and server closets to tie it all 
together.

Over 200 devices are deployed 
discreetly throughout the condo for 
gathering information about what is 
going on within. Wired into the data-
gathering equipment are audio and 
video recording devices (except in the 
bedroom and bathroom); environmen-
tal sensors for temperature, humidity, 
and air quality; communications equip-
ment; and more. Added to this are new 
types of sensors, called MITes, being 
developed by House_n researchers un- 
der a grant from the National Science 
Foundation. 

MITes (for MIT environmental  
sensors) are about the size of a large 
postage stamp and less than two centi- 
meters thick. They are portable, wire- 
less, programmable devices that can be 
optimized for one thing. Essentially 
microchips, their eventual low cost 
would let a researcher put as many in 
an environment as are needed. MITes 
are designed with simplicity and ro- 
bustness in mind, so that any person 
could take a bunch home and install 
them without the help of an expert, 
and have them actually work.

Intille described two MITes models 
for recognizing physical activity or mo- 
tion. One, a 3-axis accelerometer, is de- 
signed as a “wearable” to be attached 

N
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MIT’s Wireless Casts a Wide Net  

MIT’s campus-wide wireless network 
is nearing completion. IS&T has ex- 
panded the network by 1800 access 
points in 18 months, bringing the total 
number of access points to about 2800. 
IS&T will continue to work with de-
partments, labs, and centers, as well as 
Facilities and MIT Housing, to provide 
full wireless coverage by the end of 2005 
(though Briggs Field may need further 
boosts when spring training gets going).

You can view coverage of individual 
MIT buildings at
http://web.mit.edu/network/ 
wireless-map.html

IS&T is striving for robust connectivity 
across campus. If you are aware of any 
weak-to-no coverage areas, send your 
feedback to <unwired@mit.edu>.

iSPOTS
Dovetailing with the expansion of 

MIT’s wireless network is the opening 
of the iSPOTS exhibit on November 1 

at the MIT Museum. This exhibit fea- 
tures videos showcasing the work of 
iSPOTS, a project led by Carlo Ratti, 
Director, and Andres Sevtsuk, RA,  
at MIT’s SENSEable City Laboratory.

At the heart of iSPOTS is the ob-
servation that “the effects of complete 
wireless coverage are monumental, as 
traditional work spaces are abandoned 
in favor of more enjoyable environ-
ments such as campus lounges and 
public spaces.” iSPOTS is documenting 
these changes in real time on an elec- 
tronic color map, using log information 
from MIT’s wireless network. Over 
time, this monitoring will highlight 
how technology is modifying the use 
of public spaces on campus.  

iSPOTS is also developing an applet 
that will let wireless users share their 
MIT location information with others. 
A third planned initiative is the imple- 
mentation of a voice-over-IP system 
running on MIT’s wireless network.

To learn more about iSPOTS,  see
http://ispots.mit.edu/ispots.html ø
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THE PLACELAB

continued from page 1

to your wrist, ankle, waist, or other 
part of the body to detect physical ac- 
tivity. The device can be programmed 
in conjunction with other sensors to 
distinguish between different types  
of activity, such as sitting or standing, 
walking or running, brushing teeth or 
scrubbing windows (remember, the 
PlaceLab is just like home).

The other type of MITes is designed 
for stationary placement in or on some- 
thing, such as drawers, doors, switches, 
and telephones. The device remains in 
sleep mode until the object to which it 
is attached is moved. It then wakes up 
and sends a signal to the data-gathering 
equipment, indicating when its drawer 
or door was opened or closed, or its 
light switch turned on or off.

Driving the sensing, recording, and 
computing power are the researchers’ 
needs for details about a person’s be- 
havior in a home environment, and 
how that behavior relates to whatever 
technology is being tested. As Intille 
put it, “It’s about understanding all the 
little things that would make or break 
whether or not a particular device is 
going to work for that person.” 

Tuning In
So far, in addition to House_n and 

TIAX projects that tested sensors, two 
Media Lab thesis projects have made 
use of the PlaceLab for research. Pallavi 
Kaushik, a master’s candidate in Media 
Arts and Sciences, used the PlaceLab to 
study a reminder system for adhering to 
a medication regimen. Kaushik’s system 
takes into account what the person is 
doing to make the reminders context-
sensitive. For example, the reminder 
may be presented in one way if you just 
got out of bed, but in another way if 
you are cooking a meal. And if the sys- 
tem sensed that you took the medica- 
tion before being reminded, it would 
acknowledge that or just keep quiet.

Jason Nawyn, also a master’s can- 
didate in Media Arts and Sciences, 
developed a system to motivate less 
sedentary behavior and more physical 
activity – in other words, stop watching 
TV and get moving. Nawyn based his 
system on theories of behavior modifi- 
cation to persuade in a nonintrusive, 
positive manner, so that it is not seen 
as an annoyance.

Part of the reasoning behind these 
projects, and others envisioned for the 
PlaceLab, is to develop systems attuned 
to a person’s activity, so that reminders 
and other kinds of prompts may be 
perceived as less disruptive, and more 

helpful and welcome. For Intille, it is 
about “the subtle use of technology to 
enhance the quality of life in the home.”

A Place to Stay
The PlaceLab is open to researchers 

from departments across MIT, as well as 
organizations outside of MIT. One of its 
key functions is to be an intermediate 
testing facility between a lab situation 
and a study that involves several homes 
using portable sets of sensors. It serves 
as a “scientific instrument” for pilot 
testing and preliminary data gathering 
before moving to larger-scale studies. 
Interested researchers should send mail 
to Stephen Intille <intille@mit.edu>.

And about that “ad”? It is for real: 
the PlaceLab is seeking to increase its 
base of volunteer study participants, 
which means a stay in the condo of two 
weeks or more. For details, send email 
to <homestudy@mit.edu>. 

To learn more about the PlaceLab 
and its partners, see
House_n
http://architecture.mit.edu/
house_n/

The PlaceLab
http://architecture.mit.edu/
house_n/placelab.html

TIAX, LLC
http://www.tiax.biz/ ø  
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Mac OS X 10.4 Is Chock Full 
of Solid New Features
• Al Willis

ac OS X 10.4 (“Tiger”) is Apple’s 
fifth major release of Mac OS X 

since 2001 and, in many ways, its most 
ambitious. This version is stuffed with 
over 200 new features that enhance its 
“best of both worlds” status – combin-
ing the Macintosh’s ease of use and eye-
catching user interface with the power 
of Unix underpinnings.

However, like any new operating 
system, Tiger presents some compati- 
bility issues. For example, SAPgui 6.20 
doesn’t function properly under Tiger; 
some transactions don’t work or may 
cause SAPgui to crash. If you need a 
full version of SAPgui (as opposed to 
SAPweb), you can use Citrix to access 
the Windows version of SAPgui from 
your Macintosh. SAPgui 6.40 should be 
available for Tiger users in November.

OpenAFS is not available for Tiger; 
Apple, MIT, and contributors to the 
OpenAFS open-source project are 
working to enable this technology 
under Tiger.

New Features
Apple has posted comprehensive  

information about Tiger’s new features 
at 
http://www.apple.com/macosx/

Three of the most noteworthy are 
Dashboard, Spotlight, and Automator.

Dashboard
Perhaps Tiger’s most popular fea- 

ture, Dashboard displays selected 
mini-applications known as widgets. 
Widgets let you access information 
quickly – you can, for example, look up 
the definition of a word in the Diction-
ary widget or someone’s email address 
in the Address Book widget. Widgets 
also provide status information – such 
as the current temperature or location 
of an airline flight.

You can activate Dashboard by press- 
ing F12 or clicking its icon in the Dock. 
This causes your collection of widgets 
to appear over a dimmed desktop. 
Current windows and applications are 
unaffected. The Dashboard disappears 
again with a single keystroke.

Widgets use standard Web technol-
ogies – HTML, CSS, and Javascript – 

S o f t w a r e  S p o t l i g h t  

M

which may explain 
why over 1,000 
widgets have 
already been 
released. Apple 
maintains a catalog 
of widgets at 

http://www.apple.com/downloads/
dashboard/

Spotlight
Spotlight, Tiger’s search technology, 

maintains an index of information, or 
metadata, about your files; it automati-
cally updates the index as you create, 
delete, or modify files. Applications 
that are Spotlight-aware (e.g., Finder, 
Mail, Address Book) use the index to 
find files that match search criteria.

Clicking on Tiger’s Spotlight menu 
brings up the Spotlight field; almost  
as soon as you begin typing, Spotlight 
displays matching items. Spotlight in- 
dexes the contents of many types of 
files, such as text, PDF, and Microsoft 
Word, enabling it to display files that 
contain the text you’ve entered in the 
search field. Spotlight can also display 
items from Mail’s inbox, your Address 
Book, or an iCal calendar. You can dis- 
able certain files from being searched 
by using the Spotlight preference pane 
in System Preferences.

Spotlight also provides Smart Folder 
functionality in the Finder: by selecting 
New Smart Folder from the File menu, 
you can create a folder that contains 
files which match particular criteria – 
such as Word files labeled Special Proj-
ect that have been modified in the last 
two weeks. Any file that matches these 
criteria will appear in the Smart Folder, 
regardless of its actual location on the 
hard drive.

Finally, Spotlight is extensible; devel- 
opers can create plug-ins that enable 
new document types to be indexed and 
searched. 

Automator
Automator lets you easily automate 

a series of steps that you can repeat as 
needed – no programming required.  
If every week, for example, you use 
SAPweb to create a report, turn it into 
a PDF, and email it to ten team mem- 
bers, you could use Automator to do 
those steps on a weekly basis.

The programs that ship with Tiger, 
such as Mail, Address Book, and Safari, 
come with actions that can be linked 

together to create a workflow. You can 
save a workflow in different formats, 
depending on what it will be used for. 
For example, you can save a workflow 
as an application that can be launched 
from the Finder, or as a plug-in that can 
be accessed from a contextual menu  
in the Finder or the Script Menu. The 
scenario of needing to email a PDF to a 
team can be handled by saving a work- 
flow as a PDF print plug-in that can be 
accessed when printing the report.

Some third-party applications such 
as FileMaker 7 have built-in Automator 
actions; for more information, see 
http://www.apple.com/downloads/
macosx/automator/ 

Under the Hood
Tiger has many changes for users 

interested in what’s happening beneath 
the surface. For starters, Tiger supports 
64-bit addressing, allowing updated 
applications to use more than 4GB of 
RAM on Power Mac G5s. It also ships 
with the latest Unix commands from 
FreeBSD 5.0 and a new kernel that 
makes running on multiple processors 
more efficient. Spotlight is accessible 
from the command line by using the 
mdfind command; you can display a 
file’s metadata using mdls. Utilities  
that deal with files (cp, mv, tar, rsync) 
properly handle resource forks. For 
more about Unix features, see
http://www.apple.com/macosx/ 
features/unix/

Getting Tiger
IS&T has a limited number of Tiger 

licenses available for faculty and staff 
using MIT-owned Macs. For guidelines 
on requesting Tiger licenses, see 
http://web.mit.edu/ist/products/
vsls/mitmacos/

You can either contact your depart-
ment’s Software Liaison for install 
media or download disk images and 
burn them to CD.

Support
For help with Tiger, see the Mac  

OS X 10.4 page at 
http://itinfo.mit.edu/ 
product.php?vid=686

It covers system requirements, known 
issues, and upgrading instructions.

If you need additional assistance, 
contact the Help Desk at <computing-
help@mit.edu> or 253-1101. ø 
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This column presents announcements 
about IS&T-supported software. For 
more information about recent releases, 
see http://web.mit.edu/swrt/

N e t w o r k  N o t e s

Preferred for Email: Outlook 
Express, Outlook, Apple Mail  
• Heather Anne Harrison and Lee Ridgway

ost of us rely on email, so it 
makes sense to choose an email 

program and protocol that works well at 
MIT. IS&T has encouraged new faculty, 
students, and staff to use the email 
program bundled with their operating 
system: Outlook Express on machines 
running Windows XP Professional and 
Apple Mail on machines running Mac 
OS X. IS&T also supports Outlook 2003 
– bundled with Office 2003 Professional 
for Windows – for email.

All three programs are offered only 
as Internet Mail Access Protocol (IMAP) 
clients at MIT; support for Post Office 
Protocol (POP) is not available. IMAP, 
the recommended protocol, stores your 
email on a server so that you can access 
it from almost any connected computer.

As discussed with IT Partners and in 
other community forums, IS&T recom- 
mends that users who want to transition 
from POP to IMAP move from stand-
alone applications such as Eudora to Out- 
look Express, Outlook, or Apple Mail. 

Outlook Express
Outlook Express 6 supports 

• Easy migration of Eudora mailboxes 
and address books

• Ability to receive mail from multiple 
email accounts

• Simple Mail Transfer Protocol 
(SMTP) authentication using  
Secure Sockets Layer (SSL)

• Lightweight Directory Access Pro- 
tocol (LDAP; e.g., MIT Directory)
Outlook Express cannot be used 

with Oracle Connector/TechTime. 
While IS&T did not recommend 

older versions of Outlook Express due 
to security concerns, Outlook Express 6 
is safe to use as long as you keep your 
operating system and software up to 
date. You can do this by configuring 
Windows Update on your machine or 
by using the MIT Windows Automatic 
Update Service (WAUS) at
http://web.mit.edu/ist/topics/
windows/updates/

It’s also important to follow the 
security recommendations at  
http://itinfo.mit.edu/ 
article.php?id=7883

For details on using Outlook Express 
at MIT, go to
http://itinfo.mit.edu/ 
product.php?vid=684

Outlook 2003
Outlook 2003 offers the same fea- 

tures as Outlook Express, with a few 
exceptions.
• Importing Eudora email and address 

books into Outlook is more involved 
(see http://itinfo.mit.edu/
article.php?id=7022)

• Outlook works with Oracle 
Connector/TechTime

• Outlook lets you filter IMAP email
To keep Outlook 2003 current, apply 

the Office Updates available from
http://office.microsoft.com/en-us/
officeupdate/default.aspx

For more on using Outlook 2003 at 
MIT, see
http://itinfo.mit.edu/ 
product.php?vid=614  

Apple Mail
IS&T supports Mail 2.0 – part of 

Mac OS X 10.4, and Mail 1.3.x – part of 
Mac OS X 10.3.x. Mail 2.0 offers 
• Simple Mail Transfer Protocol 

(SMTP) authentication using 
Secure Sockets Layer (SSL)

• Lightweight Directory Access Pro- 
tocol (LDAP; e.g., MIT Directory)

• Filtering of IMAP email
• Organizing tools such as Smart 

Folders, Mailboxes, and Groups
For a full overview of features, see

http://www.apple.com/macosx/ 
features/mail/

To stay current with operating sys- 
tem, security, and Mail updates, Mac- 
intosh users should configure Software 
Update for daily checks.

For more information about Apple 
Mail at MIT, start at  
http://itinfo.mit.edu/ 
product.php?name=applemail

Support
For assistance with Outlook Express, 

Outlook, or Apple Mail – including 
help configuring IMAP –   
contact the Computing 
Help Desk at  
<computing-help@ 
mit.edu> or 253-1101. ø 

MIT Spam Screening Adds Automated 
Purging Feature  
MIT Spam Screening, available at
http://web.mit.edu/ist/services/
email/nospam/

gives users of MIT email the option of 
screening incoming messages for spam.  
Once mail is identified as spam, it can be 
filtered to avoid cluttering your inbox.

If you use an IMAP email client, 
such as WebMail, Outlook Express, 
Outlook, or Apple Mail, you can en- 
able automated purging of your Spam- 
screen folder. Until recently, automated 
purging had one setting: to delete mes- 
sages older than 21 days.

Many users requested the ability to 
purge spam messages faster, to preserve 
their email quota. That enhancement 
has been added. You can now set your 
automatic purge threshold to be any- 
where from 1 to 31 days. The default is 
still 21 days.

To update your MIT Spam Screen-
ing settings (certificates required), see  
https://nic.mit.edu/cgi-bin/ 
spamscreen

 
Support for Fetch 5.0.2 for Macintosh
IS&T now supports Fetch 5.0.2. This 
software transfers files from your 
Macintosh safely across the network to 
another computer or server using File 
Transfer Protocol (FTP). You can also 
use Fetch to perform maintenance 
tasks – such as renaming, moving,  
deleting, and changing permissions  
of files, and creating directories on a 
remote web server.

Fetch uses Kerberos and encryption 
to make your logon and transfer of data 
secure. 

The latest version of Fetch sports a 
redesigned user interface, with context- 
sensitive menus and a Recent Connec-
tions pop-up menu. It supports SSH 
File Transfer Protocol (SFTP) and offers 
improved compatibility with a range 
of servers. 

 To learn more about new features 
and how to obtain and install the soft-
ware, go to the Fetch at MIT page at
http://itinfo.mit.edu/ 
product.php?name=fetch ø
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How to Protect Yourself from 
Identity Theft
• Andrew Shafer

ersonal and financial data – such 
as your birthdate, Social Security 

Number, and credit card numbers – 
are becoming easier and easier to find 
online. This information is put into 
digital storage by the companies you 
do business with and through the 
online forms you fill out. Once this 
data is stored on a networked machine, 
you are at risk for identity theft. 

While 
you can’t 
completely 
safeguard 
yourself 
from iden- 
tity theft,  
you can 

take steps to make it harder for others 
to obtain and use your personal data.
• Order your credit report at least 

once a year, and correct any mis- 
takes you find. U.S. citizens can get 
a free credit report annually from
http://www.annualcreditreport.com

• Check your monthly credit card and 
banking account statements for un- 
known transactions. Report any 
discrepancies as soon as possible  
to the account holder or bank. 

• Never carry your Social Security 
Card in your wallet unless you need 
it that day. 

• Limit the number of your active 
credit accounts and carry only one 
or two credit cards. The more ac- 
counts you have, the greater your 
exposure to fraud. 

• Contact the company of any account 
that uses your Social Security Num- 
ber (SSN) as an identifier, and ask 
to have it changed to another num- 
ber. Be sure your driver’s license 
number is not your SSN or a deri- 
vative of it. Tell the financial insti- 
tutions you deal with (bank, credit 
card companies, mortgage holder) 
that they are not authorized to sell 
or share your contact information 
with other businesses.

• Never use easily discovered infor- 
mation for passwords or PIN num- 
bers. “Taboo-to-use” data includes 

birthdates, anniversaries, SSNs, 
middle or maiden names, family 
members’ or pets’ names, phone 
numbers, and street addresses. 

• Never give out personal information 
over the phone unless you have an 
established relationship with the 
business and you initiated the con- 
versation. If a business asks for your 
SSN, ask why they need it and what 
will happen if you don’t provide it. 
If they want it only for tracking pur- 
poses, request that they use a differ- 
ent number. If they require your SSN 
and are not a government agency 
or lending firm, consider doing 
business elsewhere.

• Limit your exposure by opting out 
of prequalified credit offers at
http://www.optoutprescreen.com

 Destroy all credit card offers re- 
ceived in the mail that you don’t in- 
tend to pursue. Shred all unsolicited 
bank checks and bank documents 
that you don’t archive to prevent 
the theft of bank routing numbers.

• Limit your exposure to telemarket-
ing calls by filling out the form at
http://www.donotcall.gov

 Charities and businesses with which 
you have established relationships 
are exempt from this, unless you tell 
them on the phone that you don’t 
wish to receive calls. Be firm, and 
don’t be afraid to hang up if a caller 
refuses to take “no” for an answer.

• Do not click on links in email asking 
you to confirm your account. If you 
believe the message to be legitimate, 
contact the company by phone or via 
its web site – which you’ve reached 
by typing its URL. Shred or delete 
any notification of “lottery winning 
distributions” and offers of wealth 
from Nigeria, South Africa, or the 
Far East.

• Keep your computer patched and 
firewalled and scan for viruses to 
prevent malicious software from 
capturing your data. For more on 
securing your computer, see 
http://web.mit.edu/ist/topics/ 

 security/

If you have questions about how  
to protect yourself from identity theft, 
contact IT Security Support at 
<infoprotect@mit.edu>. ø
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Post and Publicize Events on 
MIT’s Improved Calendar
• Susan Curran

he improved MIT Events Calendar  
at http://events.mit.edu/

is faster, easier to navigate, and quicker 
to search – by keyword, date, category, 
or event sponsor. More flexibility lets 
event planners post their events once 
and publish just about everywhere. 

Editor’s picks change on reload to 
showcase student and community life. 
Additionally, events are displayed in 
the new Lobby 7 kiosk, and may be 
selected for Tech Talk, the News Office 
web site, or the MIT home page. 

RSS and SOAP
New tools – Really Simple Syndica-

tion (RSS) and Simple Object Access 
Protocol (SOAP) – help MIT web pub- 
lishers make better use of the calendar. 

RSS lets users subscribe to web sites 
of interest. The calendar’s RSS feed 
contains a title and brief description of 
that day’s events together with a link  
to the full listing. You can subscribe  
via reader software on your computer 
or include the feed on your web site.

For programmers, there is a SOAP-
compliant web service that can be used 
to query the calendar data in more 
detail. Through this service, the MIT 
community can use the events calendar 
as a central resource and extract event 
information in customized ways. Docu-
mentation for using this API with Java, 
Perl, and PHP can be found at
http://events.mit.edu/help/soap/

Posting Your Events
Based on user feedback, there’s now 

greater flexibility when adding and 
editing events. The categories have been 
revised, and events can be listed in 
more than one category and have more 
than one sponsoring group. There’s also 
support for repeating and series events.

To display your group’s events on 
your web site, you can create a custom 
calendar with your own look and feel, 
or create a calendar with events from 
multiple groups. 

The calendar is sustained by the 
community, and relies on event plan-
ners to post their events. If you would 
like to get started posting events, visit
http://web.mit.edu/ist/services/
events/eligible.html

The calendar is a project of the In-
formation Center, IS&T, and the Office 
of the Dean for Student Life. ø
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Libraries Add Over 11,000 MIT 
Theses to DSpace 
• Heather Denny 

he MIT Libraries recently added 
over 11,000 electronic copies of MIT 

theses to DSpace – doubling the content 
of the digital archive and providing 
worldwide exposure to the work of MIT 
scholars. The MIT thesis collection is 
already one of the most widely used col-
lections of its kind. It includes the theses 
of well-known MIT alumni such as 
Charles Stark Draper ’26, Harold Eugene 
Edgerton ’27, I.M. Pei ’40, Edwin “Buzz” 
Aldrin ’63, Shirley Ann Jackson ’73, and 
Nobel Prize winners Kofi Annan ’72 
and Richard Feynman ’39, to name a 
few. In DSpace their work, and the valu- 
able research of many others, will now 
be even more accessible from the Web.

You can find theses on the DSpace 
web site at
http://libraries.mit.edu/ 
mit-theses/ 

They are organized by academic de- 
partment and can be easily searched by 

author, degree, title, thesis supervisor, 
and keyword. Each thesis has its own 
permanent Internet address, or handle: 
this link ensures that the thesis will be 
preserved and accessible in the future.

Each thesis in DSpace has two PDF 
files: a printable PDF, freely available 
to current MIT students, faculty, and 
staff (certificates required), and a view-
able, but nonprintable PDF, available  
to non-MIT users. The option to “Pur- 
chase a Printable PDF or Paper Copy” 
is available from each thesis summary 
page in DSpace. 

The entire MIT thesis collection, 
maintained by the MIT Libraries and 
Institute Archives, contains over 
100,000 doctoral, master’s, and select 
bachelor’s theses completed between 
1868 and 2005. The 11,000 theses in 
DSpace represent those that have been 
digitized since 1999, when the Libraries 
began scanning theses on demand. 
Earlier collaborations with MIT depart- 
ments also resulted in the electronic 
submission of several hundred theses. 
In 2004, the Libraries began scanning 
and adding to DSpace all new theses 
submitted to them. Recent MIT gradu- 

ates or students about to complete their 
degree may also submit their theses 
directly to DSpace by following the 
instructions at
http://web.mit.edu/etheses/

About DSpace
DSpace is a 
unique digital 
repository that 

was created in 2002 by the MIT Librar- 
ies and Hewlett-Packard to capture, 
preserve, and share MIT’s intellectual 
output with the world. Developed as an 
open-source software platform, DSpace 
has been implemented and adapted by 
hundreds of institutions around the 
globe. In addition to the collection of 
MIT theses, the content in DSpace con-
tinues to grow – it currently contains 
the digital works of 49 communities, 
representing collections of MIT faculty, 
researchers, labs, and centers. To find 
out more about DSpace or the MIT 
Theses in DSpace project, send mail  
to <dspace-help@mit.edu> or visit 
http://libraries.mit.edu/ 
dspace-mit/ ø
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How can I save my Outlook 
Express messages to my hard 

drive? I’d like to have a backup of the 
mail files stored on the IMAP server. 

Follow the steps outlined below 
to save your messages locally:  

1. On the Tools menu, click Options.
2.  On the Maintenance tab, click Store 

Folder. 
3.  Select the folder location, and then 

press CTRL+C to copy the location. 
4.  Click Cancel, and then click Cancel 

again to close the dialog box. 
5. Click Start, and then click Run. 
6. In the Open box, press CTRL+V, and 

then click OK.

This column presents tips about computing. 
If you have a question you would like to  
see answered here, send it via email to 
<techtips@mit.edu>.
For more information technology Q&As, 
check the IS&T Stock Answers database at
http://itinfo.mit.edu/answer/

3.  Verify the location of your messages 
(normally C:\Users\Eudora), and 
then click Next. 

4.  Choose All folders to import all mes- 
sages, and then click Next. You can 
also choose Selected Folders to import 
messages from one or more folders.

5.  Click Finish.

How can I back up my Address 
Book?

It’s a good idea to export and 
back up your local mail contacts 

regularly. Here’s how.
1. On the File menu, point to Export, 

and then click Address Book. 
2. Select the address book you want 

to export, click Export, and then 
proceed through the wizard.
On a related note, Outlook Express 

lets you look up contacts on the MIT 
Online Directory (an LDAP server). For 
configuration instructions, see 
http://itinfo.mit.edu/ 
article.php?id=7873 ø

7.  On the Edit menu, click Select All.
8.  On the Edit menu, click Copy, and 

then close the window. 
9.  Right-click any empty space on your 

desktop, click New, and then click 
Folder. 

10. Type mail backup for the folder 
name, and then press ENTER.

11. Double-click the Mail Backup folder 
to open it. 

12. On the Edit menu, click Paste. 
13. Close the Mail Backup window.

How can I import my Eudora 
mail into Outlook Express?

Using the Outlook Express 
Import Wizard, you can easily 

import messages from a variety of pop- 
ular email programs, such as Eudora.
1.  On the File menu, point to Import, 

and then click Messages.
2.  Select the email program you want 

to import messages from, and then 
click Next.
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EHS Inspections and Audits 
Process Moves to SAP
• Stephani Roberts Lincoln

n August, IS&T’s Administrative 
Computing delivered Inspections 

and Audits, the second phase of the 
Environment, Health, and Safety 
Management System (EHS-MS) to be 
implemented in SAP. You can find it 
via the EHS tab on the SAPweb site at
http://web.mit.edu/sapweb/

The Inspections and Audits applica- 
tion documents and tracks the depart- 
ments, laboratories, and centers (DLC) 
inspection process. This includes in- 
spections findings and corrective and 
recommended actions. A twice-a-year 
Level II inspection for the Biology De- 
partment, for example, entails checking 
off a standard list of 40+ questions. If 
the response to a question (e.g., “Are 
the ceiling sprinklers and circuit 
breakers in the labs unobstructed?”) 
results in a “finding,” the details are 
written up, along with a description  
of the action to be taken to remedy  
the situation (e.g., ask Facilities to send 
personnel to remove the obstruction). 

A follow-up inspection may take place 
to ensure that the problem was fixed. 

Before the imple- 
mentation of the 
Inspections and 
Audits applica-
tion, DLCs relied 
on a paper-based 
inspection process 
for biannual Level 

II inspections. The new system facili-
tates the creation of centralized inspec-
tion data and the tracking of inspection 
history across nearly 4,000 laboratory 
and facility areas.

Custom Worksheets 
The new application lets EHS Co- 

ordinators performing an inspection 
create a custom worksheet limited to 
questions that apply to their DLC. The 
custom worksheet can be printed out 
and used for gathering inspection  
details (e.g., findings with regard to 
OSHA-required housekeeping, safety, 
personnel training, hazards, and waste 
management). Details of the findings 
are then entered into SAPweb Inspec-
tions, and a findings report is created. 
Reports with items requiring attention 
will trigger email letters that are sent 

to appropriate parties. Some finding 
reports will require an online response 
from the responsible party. Inspections, 
reports, and responses are tracked, 
archived, and accessible to some within 
the application. An integration point 
with SAP Plant Maintenance allows for 
automatic generation of work orders to 
address findings. Reporting within a 
principal investigator’s (PI) area is 
available to the EHS Office, the DLC 
EHS Coordinator, and the respective  
PI via the MIT Data Warehouse.

The Big Picture 
Centralization of the inspection 

process gives MIT’s EHS Office a more 
complete picture of campus-wide  
efforts and encourages greater com- 
pliance. In addition to the main MIT 
campus, Lincoln Laboratory will also 
be using Inspections and Audits. With 
this new application in place, both or-
ganizations will be able to collaborate 
and strengthen the inspection process 
at MIT.

Questions?
If you have questions about using 

the EHS tab in SAPweb, send email to 
<environment@mit.edu> or call 252-
3477. ø
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A d m i n i s t r a t i v e  A s p e c t s

IS&T Launches Departmental 
Database Development
• Jeff Reed

n early August, IS&T rolled out 
departmental database develop-

ment services to the MIT community. 
These services are being coordinated 
by the Departmental Consulting and 
Application Development (DCAD) 
Team – created in response to recom-
mendations by a cross-departmental 
group commissioned by IS&T Vice 
President Jerry Grochow.

The DCAD Team has been formed 
by expanding on IS&T’s Web Commu- 
nications Services Team (WCS). In 
addition to the web consultation that 
WCS has provided to the community, 
the DCAD Team will consult with 
MIT departments, labs, and centers  
on departmental database initiatives.

Services Offered
DCAD services are intended to 

help departments meet local database 
requirements for academic, research, 
and administrative activities while 
using standard approaches and 
linkages to MIT enterprise systems. 
Services include
• Developing databases that meet 

department requirements and 
leverage the MIT infrastructure

• Helping departments migrate exist- 
ing databases to the newest version 
of products such as FileMaker

• Deploying departmental Web 
applications
After an initial consultation, DCAD 

will either work with the department 
or refer the client to recommended 
vendors who subscribe to DCAD’s 
guidelines and best practices. 

 Following on the business model 
established in WCS, select DCAD ser- 

vices will be provided at no cost while 
others will be fee-based. 
•   No-Cost Services. DCAD consultants 

will provide, at no cost, an initial 
needs assessment based on project 
goals and objectives. They will help 
find internal and external resources 
and provide needed oversight. 

• For-Fee Services. Fee-based services 
offered by DCAD include the 
creation of requirements documen-
tation; project management; data-
base development; and application 
support and maintenance.
Curious?
Starting with pilot projects, DCAD’s 

goal is to offer a robust, responsive 
service across the campus. To find out 
more about DCAD services, see
http://web.mit.edu/ist/dcad/

To discuss how DCAD might be able 
to help your department, contact the 
team at <dcad@mit.edu> or 253-3500. ø
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G e t t i n g  H e l p

S u r f  S i t e s :  H o m e  I m p r o v e m e n t

The PlaceLab is a real condo set up for 
evaluating new technologies for every- 
day living (see lead article). While auto- 
mated homes may be the wave of the 
future, there’s still a lot you can do to 
make homes with lesser IQs more effi- 
cient, comfortable, and aesthetically 
pleasing.   

If home improvement is on your  
to-do list, you may want check out the 
web sites on the right. You can find 
out about environmentally “green” 
materials, how to get a jump start on 
remodeling, or even what it takes to 
“wire” your home for the future.

BobVila.com: The Ultimate Home Site
http://www.bobvila.com/

Boston Building Materials Resource Center
http://www.bostonbmrc.org/bostonbmrc/

Energy Savers
http://www.eere.energy.gov/consumer/tips/

Greenerbuilding
http://www.greenerbuilding.org/

Home Improvement Encyclopedia
http://www.bhg.com/bhg/category.jhtml?catref=cat10002

Smarthomes: Wiring Homes for the Future
http://www.smarthomes.ie/

If you don’t know where to get help 
for your computer, network, or  
telephone problems, dial one of the 
help lines listed to the right.

If you prefer to use email, you 
can send your questions to the cor-
responding email addresses on the 
far right. (When logged into Athena, 
you can also use the olc command 
to send questions to Athena’s online 
consultants.)

You can also submit a question 
online via Casetracker at 
http://casetracker.mit.edu/

For help with… Dial… Or send a message to…

General computing questions 253-1101 computing-help@mit.edu 
Macintosh, Windows, network/ 
connectivity, business applications, 
computer buying advice

Academic computing  253-0115 et-consult@mit.edu
Athena Computing Environment 253-4435 olc@mit.edu
Computer and printer repairs 253-0815 pcservice@mit.edu
Disabilities and computing 253-7808 atic@mit.edu
Telephone and voice mail services 253-3670 telecom-csr@mit.edu
Telephone repairs 253-4357 3help@mit.edu
Unix/Linux 253-1103 unix-linux-help@mit.edu


